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Welcome to SPACEAGE
Arts & Letters SPACEAGE, endorsed by the National Space Society, is one of the Arts &
Letters EXPO Series of art, craft, and knowledge products. SPACEAGE is a 3-in-1 software
product with multimedia, clip art, and drawing. This booklet discusses the installation of
SPACEAGE and the contents of the multimedia encyclopedia, and shows examples of
SPACEAGE clip art. For instructions on how to use the drawing program portion of
SPACEAGE, please refer to the Online User’s Guide and Help in Arts & Letters DRAW.

Installation of SPACEAGE
1. Put the SPACEAGE CD-ROM in the CD-ROM drive.

2. Start Microsoft Windows. At the top of the Windows display, the title bar should read
Program Manager.

3. Pull down the File Menu and choose the Run... command.

4. Type x:\install, where x is the CD-ROM drive on your computer (D, E, etc.). Press the
Enter key on your keyboard to run the installation.

5. Pull down the Installation menu and choose Install. The Product Choices dialog box will
appear.

6. Choose the option that best suits your needs and click on OK.

SPACEAGE [Run from Disk/8.7 MB] Best performance
SPACEAGE [Disk & CD/2 MB] Average
SPACEAGE [Run from CD only] Slowest

7. The Install Options dialog box will appear. If you prefer metric units of measurement to
English, make sure the SPACEAGE DRAW Metric Setup option is highlighted in the Op-
tional portion of the Install Options dialog box. For English units, click on SPACEAGE
DRAW Metric Setup to deselect the option.

8. Follow the on-screen instructions.

The SPACEAGE CD-ROM contains three programs: (1) the SPACEAGE multimedia encyclo-
pedia; (2) Arts & Letters DRAW, a complete drawing program with a special collection of
space age clip art; and (3) the Arts & Letters EXPRESS Art Show.

For instructions on the operation of SPACEAGE Slide Shows and the EXPRESS Art Show,
please see the tri-fold booklet enclosed with the SPACEAGE CD-ROM.

Cursors
The Arts & Letters SPACEAGE Encyclopedia utilizes four cursor-shapes: the usual arrow-
shaped pointer, a pointing finger, an upraised hand, and stereo headphones:
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You use the cursors to select as you do in any Windows program.

The arrow changes to the pointing finger to alert you that you are passing over a “hot-spot”
on a map, photograph, or a key word highlighted in blue.  When a hot spot is selected, click
the left mouse button to see an explanatory popup. For example, as you move your pointer
over the photo of a satellite, it will change into the pointing finger to tell you that there is a
label or explanation available. In like manner, when the pointer changes into stereo head-
phones, you have encountered an audio clip, which you can play by clicking the left mouse
button.

When you pause a slide show or video, the cursor changes to the upraised hand, indicating
“Stop.”

Printing from SPACEAGE
Each subject window in SPACEAGE contains ”Print Setup” and “Print” buttons at the bottom.
Use these buttons to configure your printer as you would in any application and to print the
current topic to your printer.

Contents of SPACEAGE Encyclopedia
Welcome to the most complete multimedia on-line encyclopedia of spaceflight. To start
SPACEAGE, click on the SPACEAGE icon in the Windows Program Manager.

The opening screen of SPACEAGE is accompanied by a stirring rendition of the theme from
2001, the Stanley Kubrick film. This performance was orchestrated and recorded by Doug



Page

Arts & Letters SPACEAGE User’s Guide

5

Bench, of Doug Bench Productions, Dallas, Texas. (After you have once heard this overture,
you can skip it by clicking in the window as soon as the opening screen appears.)

As you move your cursor over the contents screen, you will notice that as it passes over the
pictures above the subject buttons, it changes into the “Headphones” cursor.  Click your left
mouse button to hear an audio clip pertaining to that subject.

The eight buttons launch the eight basic topics of SPACEAGE: Robotic Missions, Human
Missions, Launch Vehicles, Space Stations, Space Spinoffs, History & People, Space Cen-
ters, and the Future. Along the bottom of the SPACEAGE window are other control buttons;
the uses of these buttons (and their labels) vary with the subject you are exploring. To exit at
any time, click on the Exit button on the far right bottom.

Because SPACEAGE is updated regularly to reflect recent Shuttle missions and other topics
relating to space exploration, please note the button on the Contents screen labelled “What’s
New.” Please click on this button  for a summary of the changes since the last release of
SPACEAGE.

SPACEAGE Theater Slide Shows
Click on the Theater button in the contents screen to display a list of slide shows in the
scrolling window. Select a slide show presentation and click on the icon at the left to start the
show. The slides are narrated and offer full-screen, detailed images of people, equipment,
and historic events. To quit the slide show at any time, click the left mouse button once. To
play SPACEAGE Highlights, a collection of 40 slides selected from the various slide galleries,
press F8. The show will restart automatically when it completes a cycle. Click the left mouse
button to end the show.

Pausing a Slide Show
To pause a slide show (except Shift-F8, below), click the right mouse button once; to resume,
click it once again. Note that you can also pause video shows. The ability to pause a slide
show in an educational situation is useful for asking and answering questions about what the
audience has just seen.

Slide Show Grand Tour
Press F3 to run all of the slide shows in succession automatically.

Auto-Cycle Slide Shows
To set a slide show to run continuously, press F2 and select a slide show.

Locking the Keyboard
To lock the keyboard, press the Shift key together with F2, F3, or F8.

If you press Shift + F2 and then select a slide show, it will lock the keyboard, but you will be
able to pause the show by using the right mouse button. The only exception is Shift + F8,
which locks the keyboard and disables the pause feature to avoid interruption of the show
during unattended operation. Press Alt + F8 to end the slide show if you have locked the
keyboard.
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Custom Slide Shows
Function keys F4 and F5 play custom slide shows installed in the Windows directory on your
fixed-disk drive. This feature allows you to copy a script from the CD and modify it by
inserting custom slides in the slide shows for special occasions. Details on how to implement
this feature are available upon written request.

SpaceAGE Theater Videos
To play video highlights and the feature presentation, click on the Video button at the bottom
of the screen. A list of video selections will be displayed in the scrolling window. Select a
video from the list and click on the icon at the left to start the show. To quit the show at any
time, click anywhere on the screen.

Galleries
Most of the topics have a Gallery button. For instance, in Human Missions — Apollo 11, the
Gallery button is at the left bottom of the bank of mission buttons.

When you click on the Gallery button, the Gallery menu appears, labeled with its topic in the
upper left-hand corner. From this menu, you can select from two options:

1. Individual Slides — This option allows you to display full-screen slides illustrating the
topic. In the case of Apollo 11, the slides are actual photographs illustrating the progress
of the famous mission that landed the first humans on the Moon. Each slide is tagged
with a brief description.
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2. Audio Recordings —  This option allows you to hear the actual transmissions between
Mission Control and the astronauts of Apollo 11, as well as other pertinent contemporary
recordings.

Click on the Close button in the upper right-hand corner to exit Gallery.

Robotic Missions
Selecting “Robotic Missions” initially presents you with an alphabetic keypad in the upper
left-hand corner, with larger buttons labeled “Gallery” and “Probes.” Information about
satellites is presented in a scrolling window at the right. Selecting “Gallery” gives you a
menu of photographs of satellites, each labeled with a brief description. Clicking on “Probes”
switches you to the topic of probes, with its own gallery.

Using the alphabetic keypad, you can search a thorough listing of probes or satellites.
Clicking on a letter jumps the scrolling window to entries beginning with that letter.

The other categories of SPACEAGE operate in much the same manner, producing ever-deeper
levels of information.
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Human Missions
Click on this topic to see the major programs of the two greatest players in the Age of Space
Exploration: the United States and the former Union of Soviet Socialist Republics
(U.S.S.R.).
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The U.S. programs include Mercury, Gemini, Apollo, ASTP, and Space Shuttle. Clicking on
one of these produces a window that presents a photo, sound clip, and scrolling mission data
for each of the individual missions. The mission data is not just facts and figures; pains were
taken to include impressions of the astronauts and little-known facts.

For example, if you select Gemini, then select the Gemini IV mission, you can hear Astro-
naut Ed White, making the first American spacewalk and reluctant to end it. (And you can
hear him being told in no uncertain terms to get back in the spacecraft!) Select Gemini III,
and you’ll find that one of the astronauts smuggled a corned beef sandwich aboard for his
partner.

The U.S.S.R. programs include Vostok, Voskhod, Soyuz, and ASTP. The information to be
found in them is structured the same as that of the U.S. missions. You will share the thoughts
of the first man in space, Yuri Gagarin, as he experienced true weightlessness and looked
down upon the Earth from a hitherto impossible vantage point. You will also find out about
the returning Cosmonauts who overshot their landing zone and spent more time lost in the
Ural Mountains than they did in space.
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Launch Vehicles
This topic allows you to find the specifications of the launch vehicles, or rockets, of the
spacefaring nations of the earth. China, Europe, India, Japan, Russia, and the USA are
included. You can also browse a brief history of rocketry.

Space Stations
“Space Stations” presents information on the Salyut, Mir-1, Skylab, Alpha, and other space
stations. Photographs contain hot spots that you can click on to see more information. Also
included is a brief history of the development of space stations.

Spinoffs (of NASA Technology)
When the Space Race began in the late-fifties, Congress and the American people didn’t
particularly care about the practical applications of space travel — what mattered was
demonstrating to the world that a democracy could match or exceed the accomplishments of
a totalitarian state. Once the race to the Moon had been won, however, Americans began to
question the benefits of the space program.

“Spinoffs” lists technological applications from the space program in the areas of Computers,
Consumer, Dental, Education, Energy, Food, Industry, Medical, Safety, Natural Resources,
Telecommunications, and Transport. In all, there have been many benefits accruing from the
space program, and you’ll find them listed here.
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History & People
This topic presents an in-depth time-line survey of the history of space flight from the
beginning of this century to the present. Significant events are presented on the date on
which they occurred.  In addition, biographical sketches of major figures, such as Wernher
von Braun and Robert Goddard, are included.

Space Centers
“Space Centers” uses maps of regions of the world to allow you to locate space centers and
places of interest. At first you are presented with a map of the world. Click on a region of the
world, such as Europe, Asia, or the United States. A more detailed map of the area will
appear, displaying color-keyed symbols. Simply click on the symbols to see popups that give
you additional  information. National Space Society chapters are also located in this manner.

When you click on some map symbols, a full-screen image will appear and voice-over
narration will describe what you are viewing. Click anywhere on the screen with the left
mouse button to return to the map. To repeat the narration, click on the screen with the right
mouse button.

The Future
“The Future” allows you to view and read about launch vehicles of the future, such as the
Delta Clipper-X (DC-X), and to read about missions planned for the future, such as the
return to the Moon and the establishment of permanent bases there.
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Appendix
“Appendix” includes a dictionary of terms associated with space flight (acronyms are
explained here), a list of movies that feature space or space travel, NASA Education Pro-
grams, and Space Organizations. Interesting articles about astronauts, their space suits, and
the way in which waste is managed during space exploration are also available.  A practical
topic telling how to take political action on behalf of space exploration is also included, as is
a complete space bibliography.

Index
The SPACEAGE Search Index operates much as the familiar Windows helpfile index does.
There is one important difference, however; when you search a topic for which there are
several entries, the Index tells you how many topics by that name there are.

For example, if you search for “Space Shuttle Astronauts,” the Index will tell you that there
are 191 topics, or shuttle astronauts.
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When you click on the OK button, the Index produces a list of the topics by title, or in this
case, a list of the 191 shuttle astronauts. Click on one of the names, and the Index presents
you with the biographical sketch of that astronaut. Using the Printer Setup and Print buttons,
you can create a hard copy of the biographical sketch. You can also browse through more
names, using the alphabetical keypad in the upper left-hand corner of the window.

The Clip Art of SPACEAGE
The clip art of SPACEAGE is award-winning Arts & Letters clip art, fully-colored, highly-
detailed, and vector-based (as opposed to raster-based). In addition, many of the images are
Flex-ARTTM, which means that they are composed of discrete modules that can be manipu-
lated and modified in minutes to produce completely different poses.

You can, for example, deploy the space shuttle’s Remote Manipulating System to create a
scene showing a satellite being serviced or retrieved. You can move an astronaut’s arms and
legs to show him servicing the satellite. You can take apart images of space stations and put
them together in new and original combinations. Your freedom of composition with Flex-
ART is unparalleled. The concept of Flex-ART is discussed in detail in this manual, and
many of the pieces included with SPACEAGE are illustrated.

The history of the U.S. space program is illustrated with images from Mercury through
Apollo to the space shuttle (and its servicing of the Hubble Space Telescope), and a look to
the future with the Alpha space station. Recent Russian efforts are represented by the Mir
space station and Soyuz space craft.
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Flex-ARTTM

Arts & Letters products now include Flex-ART, the latest development in the evolution of
static clip-art images to flexible art that can be modified in minutes. Flex-ART images are
modular in design and can be easily manipulated to create dramatic results.

Using Flex-ART
When you break apart a Flex-ART image, you can select the modular pieces that make up
the image. Each module is named, and the names show in the status bar above the drawing
area as the modules are selected. For example, when an astronaut is broken apart, the result-
ing modules are “R-Upper/Lower Arm,” “Body,” “R-Leg,” “L-Leg,” and “L-Upper/Lower
Arm.” (The names also appear in the Lock/Hide/Name dialog box.)

If the name is a single or hyphenated word, such as “Body” or “R-Leg,” you should not break
the module apart any further, unless you need to change the color of its fill or the width of its
line. If, on the other hand, the module is named with two words separated by a slash (/) mark,
you can break it apart further into at least two more modules. For example, “R-Upper/Lower
Arm” can be broken into “R-Upper Arm” and “R-Lower Arm,” both of which can be ma-
nipulated separately.

Using Rotate, Bring to Front, and Send to Back, the modules can be moved in relation to
each other to create different poses.
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Rotate
Rotating modules is an easy way to change the appearance of the image. After breaking the
image apart, simply select a module and choose the Rotate tool from the toolbox. A center-
point marker will appear (the cross-hairs in the center of the selected module). The center
point marks the spot around which an object will rotate. You should move the center point to
the approximate location of a joint or hinge. For example, if you wish to rotate an astronaut’s
leg, move the center point to his hip; if you do not, the top of the leg will move away from
the body.

Once the selected module has been rotated, you may need to move it slightly to adjust its
position, depending on where you placed the center point prior to rotating. You may have to
experiment to find just the right spot from which a module should be rotated. If you rotate a
module and it doesn’t look right to you, choose Undo Rotate from the Edit menu.

The space shuttle entitled “Doors Open/RMS (Coming)” can be broken apart and the RMS
can be deployed using  Rotate. The RMS, or Remote Manipulating System, is a device that
deploys objects such as satellites from the cargo bay of the shuttle. It is also used to retrieve
satellites and pull them into the cargo bay so that they can be repaired and redeployed or
ferried back to Earth.
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When you first break apart the shuttle, you will find three modules: “Shuttle,” “Near Side,”
and “RMS 1/2/3.” This initial RMS module can be rotated out of the bay as one piece (as
shown in inset).

Then it can be broken apart into two more modules: “RMS 1” and “RMS 2&3.” “RMS 2&3”
can be rotated at the joint it shares with “RMS1.” Finally, “RMS 2&3” can be broken apart
into “RMS 2” and “RMS 3,” and “RMS 3” can be rotated at an angle from “RMS2” (as
shown in inset).

Bring to Front and Send to Back (Stacking Order)
Altering the stacking order of modules allows you to combine images to create realistic
compositions. In the example below, an astronaut and a satellite are placed in the drawing
area. (The astronaut, one of several, is the same image used in the section “Using Flex-
ART;” his arms have been flexed to create a different pose.) The satellite is maneuvered into
position behind the astronaut, and the astronaut’s right arm is selected and sent to the back.
In the resulting image, the astronaut appears to be examining the satellite. You could achieve
the same result if the satellite were in front of the astronaut; all you would do differently
would be to select the astronaut’s left arm and bring it to the front.

Stacking order is crucial to using the Flex-ART included with SPACEAGE. Many of the Flex-
ART images are composed of foreground, middle ground, and background pieces. The space
shuttle labeled “Doors Open w/Lab (Going)” illustrates this process. When you break apart
the shuttle, you produce three modules: “Far Side/RMS,” “Laboratory,” and “Near Side.
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By using the stacking order, you can place astronaut figures not only within the bay but
within the bay and behind the space laboratory.

First, break apart the shuttle into its three modules. Add the astronauts in the positions where
you want them to appear in the final composition.

There are two methods of putting the astronauts within the bay. The simpler of the two is to
select “Near Side,” pull down the Arrange menu, and click on Bring to Front. Doing so
will change the stacking order of the composition so that the “Near Side” draws last (and
over the astronauts’ lower bodies). When you look closely at the illustration, however, you
will see that one of the astronauts appears to be behind the space laboratory that is being
stored in the bay.

One way to achieve this effect is to cut that astronaut to the Clipboard. After doing so, select
the space laboratory and pull down the Edit menu. Select Paste Options and click on
Behind Object. The cursor will change to an hourglass, then to the Add Object cursor. Place
the Add Object cursor within the bay and slightly above the space lab, then click. The place
of this astronaut in the stacking order will be behind the space lab but in front of the “Far
Side/RMS.”

You can further refine a composition such as this by manipulating the astronauts’ arms and
legs to make it appear as if they are working on the shuttle or space station.

As you have seen, the image of the space shuttle is available in a number of different con-
figurations, including versions of the two previously-displayed  space shuttles, these with
their cargo bay doors shut.

Typical Shuttle Launch
Another configuration is “Shuttle Launch,” which shows the shuttle with its boosters and
external fuel tank at the moment of launch, boosters firing, with billowing clouds of exhaust.
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This Flex-ART image can be broken apart into six separate modules that can be used to
illustrate the different stages of a typical shuttle launch.

The series below was created by duplicating the basic image five times, removing or rear-
ranging parts of it, and rotating the resulting images. When “Shuttle Launch” is initially
broken apart, the modules “Launch (Smoke)” and “Launch (in flight)” appear. The module
“Launch (in flight)” is moved into position just above the original “Shuttle Launch.”

In its turn, “Launch (in flight)” breaks into the modules “Shuttle w/Boosters,” “Booster
Blasts,” and “Shuttle Blasts.” Deleting the “Blast” modules makes it appear as if the engines
have been shut down. Breaking the “Shuttle w/Boosters” apart produces a level of four
modules composed of two solid fuel boosters, the external tank, and the Shuttle itself. The
blasts of the solid fuel boosters can be deleted, and the boosters themselves can be rotated
and moved away from the shuttle to simulate their jettisoning after their fuel is exhausted.

In similar manner, the shuttle can be separated from the external tank, which can be rotated
to appear as if it is dropping away from the rising shuttle. The end product is an impressive
series of very detailed images that accurately represent a typical shuttle launch. Combined
with the detailed shuttle images previously illustrated, this series can be used to depict an
entire shuttle mission, from launch to reentry.
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The Hubble Space Telescope
The single largest problem facing astronomers on Earth is the blurring effect of the Earth’s
atmosphere. Ordinarily invisible, the air currents in our atmosphere distort observations of
distant objects in outer space. In addition to having to peer through a thick, moving atmos-
phere, astronomers have begun to have to contend with light pollution — light from cities
reflecting from the moisture in the atmosphere and lighting up the star fields that were once
completely dark. It has long been a dream of astronomers to have a telescope in space,
beyond the atmosphere and its distortions.

The Hubble Space Telescope was to be that telescope. However, after its flawless launch in
April 1990, scientists found that the main mirror of the reflecting telescope suffered from
spherical aberration. This optical problem caused a degradation in spatial resolution, or the
ability to record fine detail. Part of the disappointment was the fact that although regular
servicing had been planned for the Hubble, the main mirror was the one component that
could not be serviced in orbit.

Less widely reported and understood is the fact that even with its problems, the Hubble still
performed all tasks well. Although the Hubble’s performance was not everything that was
anticipated, the Hubble is reckoned by the scientific community to be a success.

The Hubble Servicing Mission
In addition, the Hubble received a new pair of glasses to compensate for its spherical aberra-
tion and bring its vision closer to what was originally intended. Since the mirror could not be
altered, the instruments that record its images were. During the first of their regularly-
scheduled maintenance visits, in December of 1993, astronauts successfully installed
COSTAR, the Corrective Optics Space Telescope Axial Replacement. COSTAR consists of
ten tiny mirrors that were fixed in front of the Hubble’s instruments.
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In addition, astronauts replaced other instruments, as well as faulty solar collectors that
vibrated every time sunlight hit them and caused the telescope to jiggle at inopportune
moments. One of the Hubble’s solar panels was simply disconnected and tossed overboard to
burn up in the Earth’s atmosphere.

In SPACEAGE the Hubble Space Telescope can be represented as fully operational, with its
solar panels extended and telescope uncovered, or with its solar power panels furled and its
telescope covered.

On January 12, 1994, NASA proudly announced that the Hubble repair mission had achieved
its objectives and that the telescope’s vision had been successfully sharpened. As evidence,
their spokesperson showed two photos of a distant galaxy taken by the Hubble before and
after servicing. The improvement was obvious: the first appeared to be seen through a haze;
the second was sharp as a razor.

Since then, the Hubble has continued to produce breath-taking and scientifically astonishing
photos.

The Space Shuttle Rendezvous with Mir
In February of 1986, the Soviet Union launched its most ambitious space station attempt: a
new design called Mir, or “Peace.” Mir looks like the earlier Salyut space stations, but it is
much larger and is not as jammed with scientific equipment. Cosmonauts have more room to
move around, to exercise, and to relax.

A multiple docking module, with five docking ports, allows four modules to attach to the
base unit, while a single dock in the base unit has allowed Kvant 1 to dock and expand the
station. Kvant 2 was added later, and the Kristall experimental factory module was attached
in 1990.
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The composition “Mir-1 & Shuttle” (found in Space - Compositions library) illustrates the
U.S. space shuttle’s docking with Mir. The shuttle and Mir can be manipulated separately;
each can be broken apart into its constituent modules.

Space Station Alpha
Also included in SPACEAGE is Space Station Alpha, a cooperative effort of the United
States, Canada, the European Space Agency (ESA), Japan, and Russia. Space Station Alpha
is still in the developmental stage; in fact, the designation Alpha is only one of five names
under consideration. (The other four are Unity, Alliance, Aurora, and Sigma.) The station is
represented in SPACEAGE in four different configurations.  In addition, the modules that
comprise Alpha can be rearranged to create a space station of your own design.

Alpha 1 is the first or power station phase, which will utilize simplified Freedom hardware
and other existing systems, such as the orbiter and Spacelab. A power station will be on-line
in three flights, using Freedom photovoltaic modules for a 20-day Shuttle/Spacelab mission
docked to the station. Subsystems, payload racks, and docking ports for international labora-
tories are added.

Alpha 2 is the second or human-tended capability phase of the station. With the addition of
the U.S. Common Module, a human-tended capability would be possible.

Alpha 3 depicts the third or international human-tended capability of the station. At this
point there will be a permanent human presence.

Alpha 4 is the final, or expanded, version of the station. There will be an international
community permanently occupying the station.

Mercury and Gemini
In addition to the images of present and future space activity,
SPACEAGE incorporates imagery depicting the history of
humanity’s leap into space.

Project Mercury represented the beginning of the U.S. human-
crewed space program. Mercury capsules carried a very
cramped crew of one for relatively brief jaunts into space. Like
all U.S. space flights (until the shuttle), Mercury capsules were
intended to be braked initially by the atmosphere then by
parachutes and finally “land” in the ocean.

Because they were to splashdown in the ocean, U.S. space
capsules had to be buoyant. The danger of a space capsule
shipping water and sinking when the astronaut opened his hatch
was real (and was realized when astronaut Gus Grissom lost his
capsule in just that manner). On the other hand, because of the
size of their territory and their relatively weak naval presence,
the Russians planned for their space flights to ended on land
within the Soviet Union. The Russians didn’t have to worry
about their spacecraft sinking, but they did have to consider the
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impact with which they touched down.

Following Mercury and preceding Apollo, the Gemini program was an impor-
tant stepping stone to the Moon. The Gemini capsule closely resembled the
Mercury capsule, but it was much larger, and where the Mercury capsule carried
a crew of one, Gemini carried two. (The name, Gemini, refers to the constella-
tion, whose name translates as “the twins.”) The Gemini astronauts sat side by
side with relatively greater freedom of movement and much greater control over
their capsule.

Another important difference between Mercury and Gemini capsules was that
whereas all the controls and life systems for the Mercury astronauts were
crammed into the capsule itself, the Gemini capsule moved all those systems
into a detachable Orbital Attitude and Maneuvering System that was attached
beneath the capsule. Once the Gemini was in orbit, the OAMS allowed its
astronauts to control the movements of their craft and to practice docking with a
target vehicle (the Agena) sent into orbit for just that purpose. When the mission
was over, the OAMS was jettisoned and only the capsule made a safe descent to
Earth.

The final unusual characteristic of the Gemini capsule was that for the first and
last time, astronauts had ejection seats with which to escape a launch gone bad.

Gemini had many objectives, one of the greatest of which was to give astronauts practice in
space walking, or Extra Vehicular Activity (EVA). The Gemini capsule in SPACEAGE shows
an astronaut space walking, with its hatch open to outer space. When this hatch is deleted, a
closed hatch is revealed. The capsule can also be separated from the OAMS so that the
capsule can be represented as returning to Earth.
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Like Mercury, Gemini used a parachute to break its descent to the ocean. A paraglider to
allow the capsule to return to dry land had been on the drawing boards, but before it could be
perfected, Project Gemini began and an ordinary parachute had to suffice.

Apollo 11: Humanity
Apollo was the program intended to put a man on the moon by 1970, and it was the eleventh
Apollo mission that did so.

The Apollo 11 mission to the Moon is illustrated using the “Saturn V (stages)” image. (The
other, less intricate, Saturn V image can be used when the detail available in this image is
unnecessary.) This intricate image of the Saturn V booster and its famous payload breaks
down into the smallest of detailed modules.
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The initial image is of the entire Saturn V launch vehicle. On its very tip, high above the
ground, is the Launch Escape System (1), or Rescue Tower, which was to be the astronauts’
method of escape should anything go wrong during the launch. Attached to the Command
Module, the Rescue Tower was equipped with rockets that were to lift the Command Module
a safe distance away from the Saturn V and allow the Command Module’s parachutes to
open. Fortunately, it was never needed, and the Rescue Tower was jettisoned soon after the
second stage separated from the first.

The S IC stage (2), the first and lowest stage, was composed of five powerful F1 rockets
bundled together. Combined, their thrust was equal to 53.4 million newtons, or 12 million
pounds of thrust. When their fuel was exhausted three minutes into the launch, explosive
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bolts severed the S IC stage from the ascending launch vehicle and the S II stage (3), com-
posed of five J2 rockets, was ignited. The S II stage’s rockets generated 7.1 million newtons,
or 1.6 million pounds of thrust. The rockets of S II burned for six minutes before falling
silent, then they in turn were jettisoned.

The single J2 rocket of stage IVB (4) was fired and burned for two minutes to put the
spacecraft into orbit. Stage IVB’s rocket generated 889,600 newtons, or 200,000 pounds of
thrust. After one and a half orbits, the J2 was fired once more to boost the spacecraft toward
its lunar rendezvous. After it was in a translunar trajectory, the Command and Service
Module (CSM) (5) separated from stage IVB, reversed its orientation, and docked (6) with
the Lunar Module (LM). Stage IVB was discarded, and the CSM and LM continued to the
moon.

After the spacecraft was in orbit around the Moon, the two-man crew of the LM separated it
from the CSM (7). Using its single variable thrust engine to brake their descent, they dropped
softly to the surface of the moon (8).

The first visit to the Moon was relatively short, compared to those that followed. After
establishing the presence of humanity on the Moon and leaving human footprints in the dust
of millions of years, the crew blasted off from the Moon in the Ascent Module. They used
the Descent Module as a launching pad, leaving it on the Moon, and rendezvoused in orbit
with the CSM. After the Ascent Module had docked with the CSM and its two-man crew had
reentered the CSM, the Ascent Module itself was jettisoned (9).

Shortly before achieving Earth orbit, the astronauts jettisoned their faithful Service Module
(10) and continued the final leg of their journey in the Command Module. After skipping off
the upper reaches of the atmosphere like a flat stone thrown across water, the Command
Module reentered the atmosphere, slowed sufficiently for its parachutes to open, and
splashed down in the Pacific Ocean, where it was recovered by the U.S.S. Hornet.

Lunar Module
SPACEAGE also  features a detailed image of the Lunar Module,
which can be separated into the Descent and Ascent Modules. The
reason the Lunar Module looked as angular and lumpy as it did was
that because it never had to operate within an atmosphere, with the
friction and resistance of air. In the vacuum of space and the Moon,
it needed absolutely no streamlining. Its design included the ingen-
ious idea of dividing it into two modules, each with particular tasks
to perform.

   

The Descent Module included a rocket engine that could vary its
thrust greatly and thus bring the entire Lander down gently. It also
included a “porch” and ladder to aid the astronauts in leaving and
entering. Its final task was to serve as the launching pad for the
Ascent Module, which was to rise and rendezvous with the Com-
mand and Service Module orbiting the Moon above.

“That’s one small step for
man; one giant leap for
mankind.”
       —Neil Armstrong

The figure of an astronaut, equipped with the Apollo Extravehicular Mobility Unit (EMU),
can be positioned on the ladder leading down from the Lunar Module to reproduce the
moment when Neil Armstrong became the first human to touch the surface of the Moon.
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Because the astronaut is a Flex-ART image, its arms and legs are modules separate from its
body, and these modules can be rotated and positioned to create many different poses.

The Lunar Lander proved to be more than just an exploration vehicle. In the case of Apollo
13, it served as a lifeboat, when an explosion crippled crucial life-support systems in the
Command Service Module. The astronauts abandoned their planned Moon landing and lived
in the Lunar Lander until they could return to Earth. Once in Earth orbit, they reoccupied the
Command Module, jettisoned their lifeboat and the crippled Service Module, and reentered
Earth’s atmosphere safely.

The ascent stage rocket was one of the few non-redundant systems in the Apollo program,
and if it had failed to fire, the astronauts would have been stranded on the moon with no hope
of rescue.

The rocket blast from the ascent engine shown in this sequence is “artistic license.” In the
absence of an atmosphere you would not see flames from the rocket blast as you would on
Earth.
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